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Overview
CiscoWorks for Windows is a web-based comprehensive network managem
solution for small to medium business networks.

CiscoWorks for Windows contains the following components:

• CiscoView 5.3

• WhatsUp Gold 6

• Threshold Manager

• Show Commands

• Package Support Updater

New Features
CiscoWorks for Windows Version 6 provides the following new features:

• Web interface for all applications

• Improved, unified security with single logon

• Desktop launch point for all applications

• Autodiscovery of devices using SNMP

• Hierarchical maps available on both console and client

• Improved user interface for Show Commands and Threshold Manager

• Web based Package Support Updater

• Added animated demonstrations to the online help

Supported Platforms and Browsers
CiscoWorks for Windows supports the following platforms:

• Windows 2000 Professional

• Windows 2000 Server

• Windows 2000 Advanced Server
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Device Support List
• Windows 98 (second edition)

• Windows NT 4.0 server with Service Pack 5 and higher

• Windows NT 4.0 workstation with Service Pack 5 and higher

CiscoWorks for Windows supports the following browsers:

• Netscape Navigator 4.61, 4.7 and 4.76

• Microsoft Internet Explorer 5.0, 5.0.1 and 5.5 with Service Pack 1

Note For CiscoWorks for Windows to work properly; Java, Javascript
and Cookies must be enabled in the browser.

Device Support List
Table 1 Supported and Unsupported Device OIDs

Device Name
Show
Commands1

Trap
Receiever2

Threshold
Manager3 CiscoView 5.3 WhatsUp Gold 6

AP340 Unsupported Unsupported Supported Supported Supported

AS5200 Supported Supported Supported Supported Supported

AS5300 Supported Supported Supported Supported Supported

AS5350 Supported Supported Supported Supported Supported

AS5400 Supported Supported Supported Supported Supported

AS5800 Supported Supported Supported Supported Supported

AS5850 Supported Supported Supported Supported Supported

Cat1900 Supported Unsupported Supported Supported Supported

Cat2820 Supported Unsupported Supported Supported Supported

Cat2900 Supported Supported Supported Supported Supported

Cat2900XL Supported Supported Supported Supported Supported

Cat2948GL3 Unsupported Unsupported Supported Supported Supported

Cat3500XL Supported Supported Supported Supported Supported
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Device Support List
Cat4000 Supported Supported Supported Supported Supported

Cat5000 Supported Supported Supported Supported Supported

Cat5500 Supported Supported Supported Supported Supported

Cat6000 Supported Supported Supported Supported Supported

Cat6000IOS Supported Supported Supported Supported Supported

Cat8500 Supported Supported Supported Supported Supported

CatGL3 Unsupported Unsupported Supported Supported Supported

CICS7700 Unsupported Unsupported Supported Supported Supported

FastHub300 Unsupported Unsupported Supported Supported Supported

FastHub400 Unsupported Unsupported Supported Supported Supported

IAD2400 Supported Unsupported Supported Supported Supported

MC3810 Supported Supported Supported Supported Supported

Metro1500 Unsupported Unsupported Supported Supported Supported

MicroHub1516 Unsupported Unsupported Supported Supported Supported

MicroHub1538 Unsupported Unsupported Supported Supported Supported

MicroSwitch1548 Unsupported Unsupported Supported Supported Supported

Rtr12000 Supported Supported Supported Supported Supported

Rtr1400 Supported Supported Supported Supported Supported

Rtr1600 Supported Supported Supported Supported Supported

Rtr1700 Supported Supported Supported Supported Supported

Rtr2500 Supported Supported Supported Supported Supported

Rtr2600 Supported Supported Supported Supported Supported

Rtr3600 Supported Supported Supported Supported Supported

Rtr4000 Supported Supported Supported Supported Supported

Rtr700 Supported Supported Supported Supported Supported

Rtr7000 Supported Supported Supported Supported Supported

Rtr800 Supported Supported Supported Supported Supported

Device Name
Show
Commands1

Trap
Receiever2

Threshold
Manager3 CiscoView 5.3 WhatsUp Gold 6
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Documentation Roadmap
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Documentation Roadmap
The following documents are provided in PDF format on your product CD:

• Using CiscoWorks for Windows 6.0—Provides information about the use and
operation of CiscoWorks for Windows, V. 6.0, and answers to frequently
asked questions.

• WhatsUp Gold User’s Guide—Provides information about use and operatio
of the network management system (NMS) software WhatsUp Gold.

Note Adobe Acrobat Reader 4.0 is required.

Detailed online help is also provided for the following components:

• CiscoView

• Show Commands

• Threshold Manager

StackMaker Supported

SwitchAddlets Supported

ubr7200 Supported Supported Supported Supported Supported

ubr900 Supported Supported Supported Supported Supported

URM Unsupported Unsupported Supported Supported Supported

VPN3000 Unsupported Unsupported Supported Supported Supported

1. ShowCommands depends on standard IOS CLI and Switch CLI. So, ShowCommands does not support devices whic
support standard CLI, for example AP340.

2. Trap Receiver uses SNMP to set/get Trap Receivers for Switches. For Routers it uses the CLI, Trap Receivers require
command syntax to set/get trap receivers in/from the devices. This is why there is a lesser number of devices suppo
Trap Receiver compared to Show Commands.

3. Threshold Manager internally checks if RMON is enabled on the devices. If a device does not support RMON, you w
receive an error message.

Device Name
Show
Commands1

Trap
Receiever2

Threshold
Manager3 CiscoView 5.3 WhatsUp Gold 6
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• Package Support Updater

• WhatsUp Gold

Additional Release-Specific Information Online
For information about devices supported by CiscoView, refer to:

• Device Package Readme Files—Contain information about device, card,
platform support.

• Device Package Installation Instructions—
http://www.cisco.com/kobayashi/sw-center/netmgmt/ciscoview/
cvcww-download.shtml.

Installation Notes
Note the following before installing CiscoWorks for Windows, V 6.0:

• The server where CiscoWorks for Windows, V 6.0 is installed should have
host name registered in DNS or WINS. This is necessary for the remote
clients to connect to it through the Web server.

• When launching the browser, it is recommended that there are no Java
classpath environment variables configured on the machine. This may ca
the application to operate incorrectly.

• Windows 2000 users may experience a delay when the virus scan softwa
set to scan all files.

• Do not install CiscoWorks for Windows, V 6.0 on a system (Windows NT
server, Windows 2000 Server and Windows 2000 Advanced Server)
configured as a terminal server. CiscoWorks for Windows will not functio
properly.
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Known Problems
Known Problems
Known problems are unexpected behaviors or defects in CiscoWorks for
Windows, V 6.0. They are graded according to severity level.

Known problems are located in the following sections:

• Desktop Known Problems, page 8

• CiscoView 5.3 Known Problems, page 8

• Package Support Updater (PSU) Known Problems, page 12

• Show Commands Known Problems, page 13

• Threshold Manager Known Problems, page 13

• WhatsUp Gold 6 Known Problems, page 15

• WebServer Known Problems, page 15

• Installation Known Problems, page 16

• Integration Known Problems, page 16

• Uninstallation Known Problems, page 16

• Browser Known Problems, page 17

• General Known Problems, page 18
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Desktop Known Problems

CiscoView 5.3 Known Problems

Table 2 CiscoWorks for Windows Desktop Known Problems

Bug ID Summary Explanation

CSCdt73753 Some screen graphics are not
positioned correctly.

When a system’s font size is set to Large Fonts, som
screen graphics are not positioned correctly.

Workaround: Change the font size to Small Fonts.

Table 3 CiscoView Known Problems

Bug ID Summary Explanation

CSCdr33955 Multiport monitor graphs for
device running CiscoView
display incorrect values.

To avoid problem, generate monitor graphs for
individual ports.

CSCdr34879 All ports on lennon (mod 7) are
shown as green on a Catalyst
6000 device running CiscoView.

Only ports that are configured and connected should
be shown as green.

Problem caused by lack of mapping between MIB
elements in agent and colors of ports on the board

Workaround: None.

CSCdr39315 2524 device running Cisco IOS
12.05T and CiscoView 5.x does
not display SM25-T1 card. A
blank slot is shown instead.

No solution is available at this time.

CSCdr94291 In CiscoView, NEMI
configuration dialog box for
Metro 1500 device displays N/A
as Subnet mask value.

NEMI configuration dialog box should display
255.255.255.0 as Subnet mask value.

Workaround: None.
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Known Problems
CSCds29859

CSCdt16730

When invoking CiscoView, all
CiscoWorks for Windows
browser windows close.

This occurs because the Java 1.3 plugin is not
installed properly.

Workaround: Uninstall the plugin, reboot and then
reinstall the plugin.

Note If you do not reboot after uninstallation,
the problem persists.

CSCds41560 Cannot print from the browser
selecting, File > Print.

This problem occurs if you print a chassis view using
the following steps.

1. Open a device and bring up the chassis view.

2. Select File > Print from the browser, to print the
chassis view. An error message is returned.

Workaround: Click the Print icon to print the chassis
view.

CSCds55193 Incorrect formula used to
calculate interface error
percentage is listed in CiscoView
online help.

CiscoView online help lists following as formula
used to calculate interface error percentage:
[ifInErrors /(ifInUcastPkts + IfInNUcastPkts)]
*100.

Correct formula is: [ifInError /(ifInUcastPkts +
IfInNUcastPkts + ifInError+ifInUnknownProtos)] *
100.

CSCds72290 Running CiscoView 5.x on
device with Cisco IOS 12.1(2)E
installed returns error.

Problem observed on Catalyst 2612 and
Catalyst 6509 devices with Cisco IOS 12.1(2)E
installed running CiscoView 5.0/5.1.

Following error is displayed:Failed to refresh

chassis. Refer to error log for details.

Workaround: None.

CSCds86109 CiscoView 5.x, running on Cisco
1600 and 4000 series devices,
displays a high number of
collisions.

No solution is available at this time.

Table 3 CiscoView Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCds89813 User is prompted to install JRE
on CV invocation.

User is prompted to install Java
Plugin when CiscoView is
invoked on the CiscoWorks for
Windows server even though it's
already installed during the main
install.

If you have a browser running prior to installing
CiscoWorks for Windows, the running browser is not
aware of the Java plugin until it is restarted.

Workaround:

Before installation: close all browser instances
before installing CiscoWorks for Windows.

Or

After installation: close all browser instances and
open a new browser instance for CiscoWorks for
Windows.

CSCdt02050 Flash (PCMCIA) card is not
displayed on Cisco 7000 series
device running CiscoView.

No solution is available at this time.

CSCdt04355 CiscoView console buttons
cannot be selected with Enter
key.

Problem observed in CiscoWorks for Windows.

Workaround: Use mouse or spacebar to activate
selection instead of Enter key.

CSCdt11838 When launching application,
user not prompted to install Java
Plug-in.

If RealJukeBox NS Plug-in is installed before Java
Plug-in is installed, users will not be prompted to
install Java Plug-in software when attempting to
launch application. Blank screen is displayed.

Workaround: Uninstall RealJukeBox Plug-in.

Table 3 CiscoView Known Problems (continued)

Bug ID Summary Explanation
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Known Problems
CSCdt22462 Delay when downloading Java
applets on Windows 2000
systems.

On some Windows 2000 systems, the initial
download of large Java applets (or subsequent
downloads of the same applets that are not cached
locally) might take longer than expected. After the
applet has been loaded and cached locally, the
problem no longer occurs.

The delay is caused by client side filtering
mechanisms such as virus scanning. Some virus
scanners are configured to automatically scan
content downloaded by browsers. Scanning
consumes a lot of memory and results in disk paging
on most systems.

Because of this, downloading is significantly slower
than expected. (The effect is less on systems with
large amounts of RAM and virtual memory.)

Note It is not recommended that you disable or
alter the configuration of your virus scan
software. But testing has shown, if you
disable the automatic scanning of all
download files, and instead enable the
scanning of program files only (specified
by file extension) that download times
are significantly reduced.

For more information, see the following article:
http://support.microsoft.com/support/kb/articles/q2
40/3/09.asp

Table 3 CiscoView Known Problems (continued)

Bug ID Summary Explanation
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Package Support Updater (PSU) Known Problems

Table 4 Package Support Updater (PSU) Known Problems

ID Summary Explanation

CSCdt04070 No error message is displayed
when network connection is
lost during the download of
device packages from CCO.

No solution is available at this time.

CSCdt24701 No error message is displayed
after an unsuccessful attempt
to uninstall nmidb packages.

After unsuccessful attempt to uninstall nmidb
packages, no error message is displayed stating tha
process failed. Also, in View History window,
completed successfully  is displayed under status
tab whenfailed  should be displayed instead.

Workaround: None.

CSCdt73771 Error message displayed when
multiple PSU web clients
install/uninstall device
packages at the same time.

When multiple PSU web clients install/uninstall
device packages at the same time, following error
message is displayed:Could not connect to JRun

Connector Proxy. Please contact the system

administrator for this web site.

Workaround: None.

CSCdt83908 PSU scheduled download
occurs one hour earlier than
scheduled time.

When using GMT timezone on the PSU server
machine, scheduled downloads occur one hour earl

Workaround: None.
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Known Problems
Show Commands Known Problems

Threshold Manager Known Problems

Table 5 Show Commands Known Problems

Bug ID Summary Explanation

CSCdp00095 Unable to stop Show Commands
from fetching data.

You cannot interrupt a command after it is executed
within Show Commands.

Workaround: None.

CSCdp04159 Command tree does not indicate
which commands contain
subcommands.

Only after selecting a command will its
corresponding subcommands be displayed.

Workaround: None.

CSCds41687 Current command state
(collapsed or expanded) is not
maintained when switching back
to the Show Commands main
screen from another screen.

Current command will be in collapsed state.

Workaround: None.

CSCdt77384 When the Terminal Monitor
option is set, Show Commands
does not work properly for the
device.

The additional output created by Terminal Monitor
causes a failure in Show Commands.

Workaround: Disable terminal monitor for all lines
in the device.

Table 6 Threshold Manager Known Problems

Bug ID Summary Explanation

CSCdt13888 Unable to use system type of
threshold templates for Catalyst
OS switches.

System MIB objects are not available on older
Catalyst OS switches.

Workaround: None.
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CSCdt48756 On Catalyst 1900 devices, a
Device not supported error
message appears when Trap
Receiver is launched.

CiscoWorks for Windows Trap Receiver does not
support the Catalyst 1900 device family. Catalyst
1900 devices do not support the MIB used by
CiscoWorks for Windows to set trap receivers.

Workaround: None

CSCdu06789 New devices are not visible in
Threshold Manager, if integrated
from standalone Package
Support Updater.

This problem occurs due to a bug in the standalone
version of Package Support Updater (CSCdt68504
when users add new device support. The order of
integration and Web server restart causes this
problem to occur.

Workaround: Restart the Web server by right
clicking the CWW Webserver icon in the toolbar.

Note This problem does not occur if you
integrate new device packages/device
support through the Web based Package
Support Updater.

Table 6 Threshold Manager Known Problems (continued)

Bug ID Summary Explanation
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WhatsUp Gold 6 Known Problems

WebServer Known Problems

Table 7 WhatsUp Gold Known Problems

Bug ID Summary Explanation

None Cisco icons do not appear in the
WhatsUp Gold map. Also,
cannot invoke CiscoWorks for
Windows applications
(CiscoView, ShowCommands
and Threshold Manager) on a
device in a WhatsUp Gold map.

If you have created and saved maps in WhatsUp
Gold before integrating with CiscoWorks for
Windows, Cisco icons will not appear in the saved
map and you cannot invoke Cisco Applications from
the map. This problem will exist when WhatsUp
Gold is integrated with CiscoWorks for Windows 5.0
before installing CiscoWorks for Windows, V 6.0.

Workaround: Recreate old maps after integrating
with CiscoWorks for Windows.

Table 8 WebServer Known Problems

Bug ID Summary Explanation

CSCdt64663 On Windows 2000 machines, the
CiscoWorks for Windows JRun
Engine does not restart.

When restarting the CiscoWorks for Windows JRun
Engine from the Windows desktop using: Start ->
Settings -> Control Panel -> Administrative Tools ->
Services panel and right clicking on the CiscoWorks
for Windows JRun Engine and selecting Restart, the
CiscoWorks for Windows JRun Engine stops and
restarts. But after a few seconds the service stops.

Workaround: When using the Services panel to
restart the service: use Stop to stop the service an
Start to restart the service. Do not use Restart.

None The following message may
appear in your browser:

“Could not connect to JRUN
Connector Proxy. Please contact
the System Administrator for
this website.”

The JRUN Servlet Engine takes a few minutes to
initialize.

Workaround: Wait a few minutes and Refresh or
Reload.

If the problem persists, log out of the Windows
machine (server), then log back in.
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Installation Known Problems

Integration Known Problems

Uninstallation Known Problems

Table 9 Installation Known Problems

Bug ID Summary Explanation

CSCdt48783 The “cannot open log file”
message box appears repeatedly
during installation.

There are too many files in the root directory
(Windows installed drive, usually c:\).

Workaround: Remove some files in the root
directory then proceed with the installation.

Table 10 Integration Known Problems

Bug ID Summary Explanation

CSCdp47503 NMS integration fails. NMS integration fails if the directory name, wher
the nmidb.jar file is stored, contains multiple spaces

Workaround: Rename the directory using a single
space or no spaces.

Table 11 Uninstallation Known Problems

Bug ID Summary Explanation

CSCdt07478 Unable to uninstall when
CiscoView is running.

CiscoWorks for Windows will not uninstall if
CiscoView is running on the server.

Workaround: Close CiscoView before uninstalling.
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Browser Known Problems
Table 12 Browser Known Problems

Bug ID Summary Explanation

CSCds33701 Clicking the Reload/Refresh
button on the browser menu bar
causes CiscoWorks for Windows
to go back to the home page.

This occurs in Netscape and Internet Explorer.

Workaround: Right click in the bottom frame and
select Reload/Refresh from the pulldown menu. Do
not use the Reload/Refresh button on the browser
menu bar.

CSCds92550 When using the Netscape
browser, the application
(CiscoView, ShowCommands
and Threshold Manager) links
will not be context sensitive
when the WhatsUp Gold map is
open in the right frame.

On a remote client an administrator can select from
the Home page: Tasks > User Administration and
click the Top View button, to display the network
map. From the map, the administrator can navigate
to a device and click on an application (CiscoView,
Show Commands or Threshold Manager) in the
toolbar. The application does not launch for the
device, but asks for the device information.

Workaround: Click on WhatsUp Gold from the
desktop toolbar and navigate to a device, rather tha
from the User Administration Top View link.

CSCdt74736 Show Commands tree does not
appear after resizing the browser
window.

This occurs only in the Netscape browser.

If Show Commands is launched using Netscape from
a WhatsUp Gold console map and the window is
resized, the Show Commands tree does not appea

Workaround: Click Reload/Refresh button on the
browser menu bar.

None Resizing the browser causes
CiscoWorks for Windows to go
back to the home page.

This occurs only in Netscape.

Workaround: Do not resize the Netscape browser.

Note It is recommended you maximize your
browser window when you first open
CiscoWorks for Windows.
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General Known Problems

Obtaining Documentation
The following sections provide sources for obtaining documentation from Cis
Systems.

World Wide Web
You can access the most current Cisco documentation on the World Wide We
the following sites:

• http://www.cisco.com

• http://www-china.cisco.com

• http://www-europe.cisco.com

Documentation CD-ROM
Cisco documentation and additional literature are available in a CD-ROM
package, which ships with your product. The Documentation CD-ROM is
updated monthly and may be more current than printed documentation. The
CD-ROM package is available as a single unit or as an annual subscription.

Table 13 General Known Problems

Bug ID Summary Explanation

CSCdt16691 Java fails to run on Micron
laptop (Transport NX model)
running Windows 98.

The result is a page fault in the Java.dll.

Workaround: None.
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Ordering Documentation
The Using CiscoWorks for Windows and WhatsUp Gold user guides can be
ordered using the part number CWW-Doc.

Cisco documentation is available in the following ways:

• Registered Cisco Direct Customers can order Cisco Product documenta
from the Networking Products MarketPlace:

http://www.cisco.com/cgi-bin/order/order_root.pl

• Registered Cisco.com users can order the Documentation CD-ROM thro
the online Subscription Store:

http://www.cisco.com/go/subscription

• Nonregistered Cisco.com users can order documentation through a loca
account representative by calling Cisco corporate headquarters (Californ
USA) at 408 526-7208 or, in North America, by calling 800
553-NETS(6387).

Documentation Feedback
If you are reading Cisco product documentation on the World Wide Web, you c
submit technical comments electronically. ClickFeedback in the toolbar and
selectDocumentation. After you complete the form, clickSubmit to send it to
Cisco.

You can e-mail your comments to bug-doc@cisco.com.

To submit your comments by mail, use the response card behind the front c
of your document, or write to the following address:

Attn. Document Resource Connection
Cisco Systems, Inc.
170 West Tasman Drive
San Jose, CA 95134-9883

We appreciate your comments.
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Obtaining Technical Assistance
Cisco provides Cisco.com as a starting point for all technical assistance.
Customers and partners can obtain documentation, troubleshooting tips, an
sample configurations from online tools. For Cisco.com registered users,
additional troubleshooting tools are available from the TAC website.

Cisco.com
Cisco.com is the foundation of a suite of interactive, networked services tha
provides immediate, open access to Cisco information and resources at anyt
from anywhere in the world. This highly integrated Internet application is a
powerful, easy-to-use tool for doing business with Cisco.

Cisco.com provides a broad range of features and services to help customers
partners streamline business processes and improve productivity. Through
Cisco.com, you can find information about Cisco and our networking solutio
services, and programs. In addition, you can resolve technical issues with on
technical support, download and test software packages, and order Cisco lear
materials and merchandise. Valuable online skill assessment, training, and
certification programs are also available.

Customers and partners can self-register on Cisco.com to obtain additional
personalized information and services. Registered users can order products, c
on the status of an order, access technical support, and view benefits specif
their relationships with Cisco.

To access Cisco.com, go to the following website:

http://www.cisco.com

Technical Assistance Center
The Cisco TAC website is available to all customers who need technical
assistance with a Cisco product or technology that is under warranty or cove
by a maintenance contract.
20
Release Notes for CiscoWorks for Windows, V 6.0

78-11579-02



Obtaining Technical Assistance

s to

,
Open

y
ers

ss
Contacting TAC by Using the Cisco TAC Website

If you have a priority level 3 (P3) or priority level 4 (P4) problem, contact TAC
by going to the TAC website:

http://www.cisco.com/tac

P3 and P4 level problems are defined as follows:

• P3—Your network performance is degraded. Network functionality is
noticeably impaired, but most business operations continue.

• P4—You need information or assistance on Cisco product capabilities,
product installation, or basic product configuration.

In each of the above cases, use the Cisco TAC website to quickly find answer
your questions.

To register for Cisco.com, go to the following website:

http://www.cisco.com/register/

If you cannot resolve your technical issue by using the TAC online resources
Cisco.com registered users can open a case online by using the TAC Case 
tool at the following website:

http://www.cisco.com/tac/caseopen

Contacting TAC by Telephone

If you have a priority level 1(P1) or priority level 2 (P2) problem, contact TAC b
telephone and immediately open a case. To obtain a directory of toll-free numb
for your country, go to the following website:

http://www.cisco.com/warp/public/687/Directory/DirTAC.shtml

P1 and P2 level problems are defined as follows:

• P1—Your production network is down, causing a critical impact to busine
operations if service is not restored quickly. No workaround is available.

• P2—Your production network is severely degraded, affecting significant
aspects of your business operations. No workaround is available.
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AccessPath, AtmDirector, Browse with Me, CCDA, CCDE, CCDP, CCIE, CCNA, CCNP, CCSI, CD-PAC,
CiscoLink, the Cisco NetWorks logo, the CiscoPowered Network logo, Cisco Systems Networking Academy, the
Cisco Systems Networking Academy logo, Fast Step, Follow Me Browsing, FormShare, FrameShare, GigaS
IGX, Internet Quotient, IP/VC, iQ Breakthrough, iQ Expertise, iQ FastTrack, the iQ Logo, iQ Net Readiness
Scorecard, MGX, the Networkers logo,Packet, PIX, RateMUX, ScriptBuilder, ScriptShare, SlideCast, SMARTnet
TransPath, Unity, Voice LAN, Wavelength Router, and WebViewer are trademarks of Cisco Systems, Inc.; Chan
the Way We Work, Live, Play, and Learn, Discover All That’s Possible, and Empowering the Internet Generation
service marks of Cisco Systems, Inc.; and Aironet, ASIST, BPX, Catalyst, Cisco, the Cisco Certified Internet
Expert logo, Cisco IOS, the Cisco IOS logo, Cisco Systems, Cisco Systems Capital, the Cisco Systems logo
Enterprise/Solver, EtherChannel, EtherSwitch, FastHub, FastSwitch, IOS, IP/TV, LightStream, MICA, Networ
Registrar, Post-Routing, Pre-Routing, Registrar, StrataView Plus, Stratm, SwitchProbe, TeleRouter, and VCO
registered trademarks of Cisco Systems, Inc. or its affiliates in the U.S. and certain other countries.

All other brands, names, or trademarks mentioned in this document or Web site are the property of their resp
owners. The use of the word partner does not imply a partnership relationship between Cisco and any other com
(0102R)
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